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SECTION 1 INTRODUCTION

BOD Analyst software ™ for Windows™ (BOD Analyst software) is a Windows-based PC
software accessory to the YSI 5000 and 5100 Dissolved Oxygen Instruments.  Once you have
defined your particular BOD application in the software, it will be able to control the YSI
5000/5100 Dissolved Oxygen Instrument and help to automate your BOD readings.  At your
signal, the software will collect each DO reading from the YSI 5000/5100 Dissolved Oxygen
Instrument, match initial and final dissolved oxygen readings, perform all of the necessary
calculations, and generate a report.

The program is very easy to learn and use.  Most applications will require only a couple of hours
to set up.  Setup includes installing the YSI 5000/5100 Dissolved Oxygen Instrument, installing
the program on to your PC, and defining your application.  Once that is accomplished, you will
only need a few minutes each morning to define exactly what you intend to do that day.

1. 1 INSTALLING THE YSI 5000/5100 DO INSTRUMENT

Your RS232 connectors are "D" shaped and have two rows of pins with a total of either 9 or 25
male contacts.  Occasionally a PC will have the connectors labeled with "RS232", “IOIOI”,
"COM1", "COM2", etc.  You may already have a device connected to an RS232 port.  Typical
devices include; a mouse, modems or printers.  The program will need to know which
communications port will be used for the YSI 5000/5100 DO Instrument.  If you don't know,
don't worry!  Just plug it into any 9 or 25 pin connector.  If the program cannot communicate with
the YSI 5000/5100 DO Instrument, simply change the COM port field from Setup,
Communication Setup.  See Section 11, Customizing Your Program for detailed instructions.

If the RS232 connector on your PC has 25 pins, you will need to 9-25 adapter.  Plug one end of
the cable into the PC. Plug the other end into the YSI 5000/5100 DO Instrument.

1.2 INSTALLING YSI BOD ANALYST SOFTWARE ON YOUR PC

1. In Windows, close all programs that are currently running including any toolbars.

2. Place the BOD Analyst software CD in your CD-ROM drive. The setup program will start.  If
the setup program does not start, you will have to manually start the setup program.  For
Windows 95 and 98 choose [Start]; [Run] from the Start Bar.

Follow the instructions on the screen and the installation program displays the following box:
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Click OK to proceed.

The installation program will then display the following screen. Click the button with the picture
of a computer to begin the installation.

From this point, the installation program prompts you to place the BOD Analyst software disks in
the disk drive. Simply follow the instructions on the screen to complete the installation.  Upon
completion of the installation, a program group with a BOD Analyst software icon will be setup.
The program group will be located in the Start, Programs menu.

1.2.1 STARTING THE PROGRAM

Click on the BOD Analyst software icon that was set up in the installation program.  The BOD
Analyst software bench sheet screen will be displayed.

BOD ANALYST for Windows



Introduction Section 1

YSI Incorporated BOD Analyst for Windows Software 3

The Bench sheet is the main form of the BOD Analyst software.  From the bench sheet all
functions of BOD Analyst software are found.   A day’s batch is retrieved into the bench sheet so
the DO readings can be taken, the BOD’s calculated, the criteria applied to the tests, and the Final
BOD stored.  Data is stored in a Microsoft Access database, by default the database is data.mdb.
The current database is displayed in parentheses in the BOD Analyst software title bar.  BOD
Analyst software allows multiple databases that are created and accessed through the File menu.
See Section 9.3, Understanding Data Files for more information.

1.3 QUICK START GUIDE

After installation you must accomplish the following steps in order to start reading your dissolved
oxygen readings.   These steps are listed as a general guideline to introduce you to the program.

Step 1: Review BOD Analyst software default settings

When you first use BOD Analyst software some settings are defaulted to the most common
settings.   These settings can be changed to user specified setting. For example, the bottle volume
is set to 300ml.  You may want to review these settings before getting started.  The following
tables summarize all the settings and the menu option to change them.

General Settings
Menu: Setup, General
More Information: General Setup Form

Settings                             Value
Derive Initials Off
Blank Compensation Off
Do you predilute your bottles Off



Introduction Section 1

YSI Incorporated BOD Analyst for Windows Software 4

Volume of bottles (ml) 300
Dilution Unit ml
Seed Added to Bottle
Report Font Arial

YSI Instrument Parameters Form
Menu: Setup, YSI Instrument Parameters Form
More Information: YSI Instrument Parameters Form

Settings                             Value
Technique Manual
Stabilize timeout 300 secs.
Sample Hold Time 10 secs.
Sample change (mg/L) 0.05
Blank Hold Time secs. 5
Blank change 0.02
Initial low temp 16
Initial high temp 24
Final low temp 18
Final High temp 22
Supersaturation 9.09
Bottle Numbers On
Barcode reader (5100 only) Off

Communications Setup
Menu: Setup, Communications Setup
More Information: Communications Settings Form

Settings                             Value
COM port Com1:
Baud Rate 9600

Criteria Setup
Menu: Setup, Criteria
More Information: BOD Criteria Setup

Settings                                                                                     Value
Maximum Dilution Blank Oxygen Depletion (mg/l) 0.2
Maximum Initial Dissolved Oxygen (mg/l) 9.7
Minimum Final Dissolved Oxygen (mg/l) 1.0
Apply Take 2 leave 1 Rule On
Minimum (Initial DO - Final DO) (mg/l) 2.0
Remove Depletion caused by Seed Off
Minimum Oxygen Depletion % for Seed Tests (mg/l) Disabled
Maximum Oxygen Depletion % for Seed Tests (mg/l) Disabled
Use Seed that was closest to 50% depletion On
Minimum Seed Correction Factor (mg/l) 0.6
Maximum Seed Correction Factor (mg/l) 1.0
Minimum Standard Test BOD (mg/l) 163
Maximum Standard Test BOD 237
Check Coefficient of Variation Off
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Coefficient of Variation Limit 0.35
Apply Criteria after Final Readings On

Step 2: Setup Samples

Next, you have to setup the Samples you run in the BOD Analyst software.  BOD Analyst
software by default has the DilBlank, Seed, and Standard Samples setup.  From the Main Menu,
choose Setup, Samples to add your samples and review the default samples.  See Section 2,
Samples for more information.

Step 3: Setup a Batch

From the bench sheet, enter a sample date, then press Tab, or use the pull down menu to assign a
date. The Build Batch form will then be displayed. The build batch form is used to specify the
samples and their dilutions for the batch.

The table on the Build Batch form describes the batch.  Select the samples you want for the batch
by selecting the sample from the Choose Samples listbox and use the > button.  After all samples
are added to the table, click OK and the batch will be setup.

Step 4: Read Initials

You are now ready to read initial DOs.  Select Read, Initials from the Main Menu.  Follow the
prompts on the YSI 5000/5100 Instrument or the PC to read your initial values.  All data is
automatically saved.

Step 5: Read Finals

Five days later, restart the BOD Analyst software.  Select the Sample Date to load the batch.
Select Read, Finals from the Main Menu.  Follow the prompts on the YSI or the PC to read your
final values.  BOD Analyst software will calculate Final BODs, “mark” bottles that do not meet
the criteria, and save the data.



SECTION 2 SAMPLES

2.1 WHAT IS A "SAMPLE?"

With YSI’s BOD Analyst software you can organize your work by sample.  A sample is anything
for which you want to know the BOD.  Samples for BOD can be taken from various points in
your wastewater treatment system or environmental water:

Raw north plant effluent
Clarifier Tank #2 combined sewer overflow #17
CBOD effluent Green River upstream of outfall

Samples can also come from industries or other large polluters:
Dairy farm refinery
ABC metal plating army base

In the BOD Analyst software, Samples also include some things that are done only in support of
the other measurements:

Seed control sample dilution water blanks
GGA standard distilled water blank

In the BOD Analyst software, a "Sample" is not just the name of the stuff for which you want to
know the BOD, but also all the information about how you measure the BOD for that Sample.
Specifically, a Sample definition includes the following information: a name; a description; the
dilutions that you usually run for that Sample; whether or not the Sample is seeded, and if so, how
and whether or not the Sample is a CBOD.  You define Samples in the BOD Analyst software on
the Sample Form.  The Sample Form is accessed from the menu by selecting Setup, Samples. A
Sample for "north plant effluent" would look something like this:
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In this example, there are two dilutions: 150ml and 275ml.  This Sample is seeded with 3ml of
material taken from the Influent.

2.2 USING SAMPLE SETUP

The Sample Setup Form is used to add new Samples to the database or to change old ones. The
Sample Setup Form is accessed from the menu by selecting Setup, Samples. Sample Setup
information is used as defaults when adding a sample to a day’s batch.   For example, we setup
Influent with three dilutions of 5, 8, and 10 ml and no seeding.  Every time the Influent Sample is
added to a batch, three dilutions of 5, 8, and 10 ml will be setup saving time and data entry errors.
The dilutions and number of bottles can be changed for any batch using the main bench sheet
screen.   Use the button bar to navigate, add, and delete samples.  Changes to samples are
automatically saved.

2.3 ADDING A NEW SAMPLE

To add a new Sample, select Setup / Samples from the Menu.  Click the Add New button from
the toolbar.  A blank Sample Setup form will be displayed.  Simply fill out the fields for the new
sample.  Changes are automatically saved.

The following paragraphs describe each of the fields on the form.

Sample Name: Sample names can be up to 15 characters long.  Names longer than 13 characters
are shortened when displayed on the YSI 5000/5100 Instrument. You may use upper and lower
case characters in a name.  When it is necessary to abbreviate a name, lower case letters will be
eliminated before upper case letters.  Keep in mind that editing a Sample name will cause the new
name to appear even on reports of old data.  For example, if you edited the Sample, "clarifier,"
and changed its name to "secondary," when you print a report of a Batch that included a BOD of
the "clarifier," the Sample name would be reported as "secondary."  Therefore, be careful to only
edit a Sample name when the new name is just a different name, and not an entirely different
Sample.

Description: You can have up to 50 characters to describe the Sample.  The Sample name is
often descriptive enough by itself and you do not need to fill in this field. However, sometimes a
description is helpful.  For example, a Sample name like "W C s Efflnt" may need a description
like "West plant CBOD seeded effluent."

Move to the
first record

Move to
previous record

Move to next
record

Move to last
record

Add a new
blank record

Delete the
current record
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Dilution Setup: You can have up to 5 dilutions for any Sample. On the General Setup Form, the
dilution unit field allows you to choose to express your dilutions in milliliters (ml) or in percent
(%).  If you change dilution units on the General Setup Form, all of the dilutions in each of your
Samples will be changed automatically to reflect the new units. Dilutions can have up to two
places after the decimal point and three before it, however, on the YSI 5000/5100 Instrument
display, more characters for the dilution may mean fewer characters for the Sample name.  So, try
to keep your dilutions to 3 or 4 characters or less (e.g. 300, 120, 75, 2.5).

Seed control sample name: This field is used to indicate the name of the seed control sample.
Simply choose the sample to be used as Seed control from the pull down list.  Choose ‘No
Seeding’ from the pull down list for Samples that are not seeded.  Only Samples that have the
Used as Seed field selected will appear on the list. Note that you will have to define your seed
control samples before you can define any seeded Samples.  Often a plant's effluent is seeded
with material from the plant's influent.  First define a Sample called "Influent."   When you are
ready to define a Sample for the effluent, the seed control sample, "Influent" will be available for
selection. The next section is devoted to the topic of seeding.

Seed Qty in ml: Sets the quantity of seed material used for this Sample.  The interpretation of
this field depends on the seeding method that you have selected on the General Setup Form.  If
you have chosen to add seed directly to each bottle, then the number in this field represents the
number of milliliters of seed material in each seeded bottle.  If you have chosen to add seed
material to the dilution water, then the number represents the number of milliliters of seed
material in each liter of the dilution water that is used for seeded Samples.  In this case the field
will appear as Qty (ml/L):.

Standard:  Treat sample as a GGA standard test.  Standard tests have the Minimum and
Maximum Standard Test criteria applied to the tests.

Dilution Blank: Treat sample as a dilution blank test.  Only the depletion is calculated for these
tests. The Maximum Dilution Blank Oxygen Depletion criteria is applied to Dilution Blank
Tests

Used as Seed:  The sample can be used as a seed.  With Used as Seed checked, a seed correction
will be calculated for the sample.

CBOD:  If the Sample is a CBOD, check the box.  This has absolutely no affect on the
calculations.  It is only so that CBOD can be indicated on reports.

Decimal Points:  The number of Decimal Points the final BOD for the sample should be
calculated to. Default is 0.

Pre-dilution:  (The pre-dilution option is only shown when the General Setup Form option is
checked). Very strong samples sometimes require dilutions that would be difficult to make in one
step.  In these cases, a sizeable quantity of sample is first diluted to a ratio that will make the final
dilutions practical.  In the BOD Analyst software, we call this ratio the pre-dilution.  For example,
if you add 10ml of your dairy farm sample to a 1000ml volumetric flask and then fill the flask
with dilution water, we call that a pre-dilution of 100.  It is sometimes referred to as a serial
dilution.  Some people find it easier to adjust for the strength of each sample with the pre-dilution
while keeping the final dilutions constant for all samples.  Seed control samples, and blanks
cannot be pre-diluted.
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Quality Control: Used in the trending graph function to display Quality Control Limits on the
graph for the sample.

2.4 CHANGING A SAMPLE

Use the button bar to move to the sample (record) you want to change.  Edit the fields as required.
Changes are automatically saved. Keep in mind that editing a Sample name will cause the new
name to appear even on reports of old data.  For example, if you edited the Sample, "clarifier,"
and changed its name to "secondary," when you print a report of a Batch that included a BOD of
the "clarifier," the Sample name would be reported as "secondary."  So, only edit a Sample name
when the new name is just a different name for the same thing and not an entirely different
Sample.

2.5 NAMING SAMPLES

When recording BODs by hand, many people develop very brief abbreviations for their samples
to save time and aggravation.  With the BOD Analyst software, this is no longer necessary.  We
recommend that you try to use Sample names that are as close as possible to normal, everyday
English.  For example, in naming an upstream river sample, why say MU, when you could say
Mad R Upstr ?

The Sample name can be up to 15 characters long.  The full Sample name will always appear on
the PC and on all reports.  However, the YSI 5000/5100 Dissolved Oxygen Instrument's display
is limited to a total of 13 characters for both the dilution and the Sample name.  But do not
hesitate to use long names. The program will automatically abbreviate them in an intelligent
fashion.  Let's look at a couple of examples.

Suppose that we do BODs for 2 plants, north and south, and that we run CBODs and full BODs
on the effluents from each plant.  Let's further suppose that for each of the samples we run a 100
ml dilution (among others, of course).  The idea is to name the samples such that when they
appear on the YSI 5000/5100 Dissolved Oxygen Instrument display it is easy to distinguish them.
There are many good ways to do it.  Putting an N or an S at the beginning of the names would
group Samples from the same plant together on the alphabetical Sample List.  Let's name them as
follows:

N C Effluent N Effluent
S C Effluent S Effluent

Now let's see how these names would appear on the YSI 5000/5100 Dissolved Oxygen
Instrument display:

                   

NCEffluent 100i
Enter Bot#:0

N Effluent 100i
Enter Bot#:0

SCEffluent 100i
Enter Bot#:0

S Effluent 100i
Enter Bot#:0
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You can find a detailed description of the abbreviation algorithm in the next section.  The only
thing that you need to remember is that characters at the end of the name will be the first to go.

2.5.1 ABBREVIATION ALGORITHM

The abbreviation algorithm is simple.  It attempts to remove the least important characters first,
removing one at a time until there is room for the dilution and the new abbreviated name.  It starts
at the end of the Sample name and moves back.  The program removes characters in this order:

- Spaces
- Punctuation
- double, lower case letters
- lower case vowels
- lower case consonants
- upper case vowels
- upper case consonants
- Truncate to 8 characters

2.6 DELETING A SAMPLE

Keep in mind that when you remove a sample, its name will remain in the database so that
future reports of old data will have sample names.  For example, if you decide that you no

longer need to do BODs on your "clarifier," you can delete it and it won't appear on the Sample
list.  If you later want a report of a batch that included a BOD of the "clarifier," it will still appear
on the report.

To delete a sample, move to the record using the button bar and click the button.



SECTION 3 SEEDING SAMPLES

3.1 WHY SEED?

Seeding is necessary when there are not enough bacteria present in the sample.  A small amount
of seed material that is known to have adequate bacteria is added to the bottle along with the
aliquot and dilution water.

Seeding is most often necessary with an effluent sample that has been chlorinated.  The seed
material can come from the plant's influent, from some intermediate point in the process, or from
commercially available seed packets.

If you don't seed at all, then you can ignore this section, but be sure that you do not fill in the
Seed Control Sample Name or seed Qty (ml):  fields on any Sample Setup Form.

3.2 SEED CONTROL SAMPLE

In a seeded sample both the sample and the seed contribute to the depletion.  Since it is the BOD
of the sample that is of interest, we must remove the effect of the seed material in our
calculations.  To determine this compensation, you must run several dilutions of the seed material
itself.  This is called the "seed control sample."  The sample name of the seed control sample
must be indicated in the Seed control sample Name field on the sample setup form.  Sometimes
the seed material is taken from a sample that is already being tested for BOD, typically the
influent.  In these cases, enter Influent in the Seed control sample Name field.  Sometimes there
are seeded samples for which the CBOD is to be determined, and others for which the full BOD
is to be determined.  In these cases, it may be necessary to have two seed control samples of the
same material, one a CBOD and the other a full BOD.

Seed control samples cannot be pre-diluted. (Neither can blanks)

3.3 SEEDING METHODS

You may choose one of two seeding methods, adding seed material to each bottle that is to be
seeded, or adding seed material to the dilution water.

If you choose to add seed material directly to each BOD bottle, the quantity of seed material is
expressed in milliliters (ml).  If you choose this method, you must put the same quantity of seed
material in each of the dilutions of the same sample.  However, if you have more than one seeded
sample, each sample may have a different quantity of seed. 

If you choose to add seed material to the dilution water, you must first mix the seed material with
dilution water and use the mix to dilute all of your seeded sample dilutions.  Note that the amount
of seed material in each bottle depends on the amount of dilution water in the bottle.  The
quantity of seed material is expressed in milliliters per liter.  Typically, the same seeded dilution
water is used for all seeded samples.
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If you seed directly to the bottle, the amount of seed material in each bottle will simply be the
seed quantity.  If you seed the blank water, the amount of seed material in each bottle depends on
how much dilution water is in that bottle.  Note therefore, that your choice of method will affect
the calculations.

You may, after some time, decide that it would be best to change your seeding method.  You can
change the seeding method on the Seed added to: field on the General Setup Form.  Furthermore,
because the units for the seed quantity are different for the two methods (ml of seed material in
each bottle vs. ml/L of seed material in dilution water), you must adjust the seed quantity for each
of your seeded samples to reflect the new method.

NOTE: The BOD Analyst software shows only one method of adding seed. Therefore, when you
change the method used for seeding, all previously taken batches will be translated to reflect the
current method. This is for display purposes only and WILL NOT affect your data.



SECTION 4 SAMPLE GROUPS

4.1 WHAT IS A "SAMPLE GROUP"?

A Sample Group is a set of samples.  For brevity, we often refer to Sample Groups as simply
Groups.  You will want to define a Group for every set of samples that you do frequently.
Groups allow you to bring a number of samples into a Batch quickly and easily.

A Group definition includes a name, a description, and the sample names of the group.  You will
want to list the Samples in a Group in the same order that you typically measure them.

Since Groups do not appear on any report, there is no need to keep a permanent record of them.
So, unlike Samples, when you delete a Group, it is gone forever.

4.2 THE GROUP SETUP FORM

The Group Setup form is used to add, edit and delete groups.  Select Setup / Groups from the
Main Menu to access the Group Setup form.

4.3 ADDING A GROUP

From the Group Setup form, click the ADD NEW button.  A blank form will be
displayed.  Enter the Group Name and choose the samples from the Group (see the

section below for more information on choosing groups).  Changes are automatically saved.
Samples will be added to the batch in the order they appear in the Group.  The build batch form
allows you to reorder the samples. An unlimited number of samples can be in a batch.
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NOTE: The dilution blank sample is automatically added when you build a batch.  Therefore,
you do not need to add the dilution blank sample to any group.

4.4 CHOOSING SAMPLES FOR GROUPS

The Choose Samples list displays all available samples.  The Samples in Group list displays the
samples that are in the Group.  Use the transfer buttons described below to add or remove
samples from the Group.

Transfer all selected samples from the Choose Samples list to the Samples in
Group list.

Transfers all samples from the Choose Samples list to the Samples In Group
list.

Removes all selected samples from the Samples in Group list

Removes all samples from the Samples in Group list.

4.5 EDITING A GROUP

Use the button bar to move to the Group that you want to edit.  Change the Samples in Group
list as required.  The Group name can also be changed at anytime with no effect on historical
data.  Changes are automatically saved.

4.6 DELETING A GROUP

Use the button bar to move to the Group that you want to delete.  Click the [Delete]
button. You will be asked if you are sure, click Yes to delete the group.



SECTION 5 BATCHES

5.1 WHAT IS A "BATCH?"

A Batch is all initial DOs that are done on any one day, along with their corresponding final DOs.
Because there is only one Batch per day, we can refer to a Batch by the Sample Date.

It is very important that the date on your computer is correct.  The date when you read the initials
and the date when you run the finals set the incubation period for the batch.  If the date on the
computer is incorrect, the BOD Analyst software may not calculate the BODs correctly.

There are several safeguards built into the program to help you avoid making a mistake.  The date
and the day of the week are displayed in the upper right hand corner of the screen at all times.

A Batch must be self-contained.  That is, if there are any seeded Samples in the Batch then the
corresponding seed control samples must also be present.  When a batch is built, a warning
message will be displayed and the batch will not be built if this condition exists.  Once the batch
is built, you can delete the seed control sample from the bench sheet.

5.2 LOADING A BATCH

To load a batch into the Bench Sheet enter a date into the Sample Date field.  If a batch for the
day has been started, it will be retrieved into the Bench Sheet.  If no batch is found for the day the
Build Batch Form will be displayed allowing you to load a Bench Sheet with a new batch. Dates
can be entered in mm/dd/yy or mm/dd/yyyy format.  Alternatively, you can use the dropdown
calendar to select a date.

To select a batch that is not yet complete, click the List Open Batches button .  A form  will
open displaying batches, within the last 33 days, that have no finals taken.  Simply select the date
from the list and click OK.  For a display of all batches, click the All option button.



Batches Section 5

YSI Incorporated BOD Analyst for Windows Software 16

The Open Batch Form can also be used to delete a batch.  Select the batch to be deleted and click
[Delete].  You will be asked for confirmation before deletion.

5.3 THE BUILD BATCH FORM

From the bench sheet, when a Sample Date is entered that has no batch setup for it, the build
batch form will be displayed.  The build batch form is used to specify the samples and their
dilutions for the batch.

The table on the Build Batch form describes the batch.  Each line in the table is a Sample.
Sample Names appear in the first column.  There are 5 columns for the Samples’ dilutions.  Use
the mouse or the arrow keys to move through the table.  To change the dilutions for any sample,
move to the dilution and enter a new number.  To remove a dilution from the sample, simply clear
the dilution field. The Seed Name and Seed Qty columns describe the Seed for the sample.
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5.4 WORKING WITH BATCHES

5.4.1 STEPS TO BUILDING A BATCH

Add the samples for the batch by:

1.  Click on a group in Choose Groups and then click to add all the samples for the
group to the batch.  You can also drag and drop the group onto the batch to add the samples to the
batch.

OR

Click on a sample in the Choose Samples and then click to add that sample to the
batch.  You can also drag and drop the sample onto the batch.

2. Use to change the order of the samples.  Simply click on a row and then
use the arrow buttons to move that sample up or down in the batch.

3.   Edit the dilutions and Seed information as necessary.

4.  Click the OK button. The batch will be loaded into the bench sheet and will be ready for initial
DOs to be read.

5.4.2 REMOVING A SAMPLE

To remove a sample from the build batch table, move the cursor anywhere on the sample row in
the table and click the Remove Sample button.

5.4.3 CLEARING THE BATCH

To remove all samples from the batch, click the Clear Batch button.  This will give you a clean
slate from which you can build your batch.   Alternatively, use the Delete button on the open
batch form.

5.4.4 ADDING MORE THAN 5 DILUTIONS

In some cases, a sample will require more than five (5) dilutions.  From the build batch screen
there is no way to enter more than 5 dilutions.  To handle this situation, first build the batch with
5 dilutions.  Then use the Add Bottle button on the bench sheet to add more bottles (dilutions) to
a sample.  BOD Analyst software allows you to run duplicate or triplicate bottles for each
dilution.  Use the Number of Bottles per dilution field on the Build Batch screen to run
duplicates.  For example, with this field set to 2, for each dilution two (2) bottles will be setup for
the batch.
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5.4.5 IMPORT BATCH

This feature allows you to setup a batch by importing a text file created in another system (i.e. a
LIMS).  The LIMS needs to build a file with the sample names followed by an optional serial
number, one pair per line.  Sample names in the file must exactly match sample names defined in
BOD Analyst software (however, Sample names are not case sensitive).  For example, if the
sample name in the import text file is raw and the Sample is defined in BOD Analyst software as
Raw, they would still match.  The Raw sample would then be added to the batch according to
how the Sample was setup in BOD Analyst software.  See Section 2.2, Using Sample Setup for
more information.   The text file has the following format: columns 1 through 12 for the Sample
Name, columns 14 through 21 for the Serial Number.  Here is an example import file:

Column 1 Column 14
↓ ↓
Sample1 serno
Raw 000456
Final 000457

If the Serial Number is included in the import file, the serial number in the file will override the
serial number that would be generated by BOD Analyst software.   To import a batch, select
Utilities, Import Batch and the Import Batch form will be displayed.

Select the date to be imported and enter the Import File Name.  The … button allows you to
browse for the import file.  Click OK and the batch will be setup.

5.5 THE BENCH SHEET

The Bench Sheet is the main form of the BOD Analyst software.  From the Bench Sheet all
functions of BOD Analyst software are found.   A day’s batch is retrieved into the Bench Sheet so
the DO readings can be read, the BODs calculated, the criteria applied to the tests, and the Final
BOD stored.

5.5.1 DATA ENTRY

Data is entered from the keyboard in a spreadsheet fashion or read from the YSI 5000/5100 DO
Instrument.  Data to be entered includes the bottle number, amount of sample used, amount of
seed used, initial dissolved oxygen reading and final dissolved oxygen reading.  For each test the
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dilution oxygen depletion, seed correction factor and BOD are calculated automatically.  For each
set of tests having the same sample name, a Final BOD is found by averaging BODs for the
sample.  When tests are checked for validity, the Final BOD is automatically recalculated using
only those tests that meet the criteria.

5.5.2 MARKING/UNMARKING

Tests can be checked for validity using limits set in Criteria Setup.  Tests are checked against
limits after final readings have been complete (if the Apply Criteria after final readings) or by
clicking the CHECK button. Tests that do not meet the criteria are automatically "marked" as
unacceptable.  Marked data are shown on the screen with a green background.  Tests may also be
marked and unmarked independently of the criteria using the MARK and UNMARK buttons.
Upon marking, Final BOD values are recalculated using only the unmarked tests.

5.6 READING INITIAL DO’S

Select Read / Initials from the Main Menu.  This will connect to the YSI 5000/5100 DO
Instrument and begin reading in the Initial DOs.  As the DOs are read from the YSI 5000/5100
DO Instrument the data will be stored in the Bench Sheet.

5.7 ADD A BOTTLE

Click the NEW BOTTLE button to insert a bottle into the current sample after the
current row.    You may need to add a bottle if you setup the wrong number of
dilutions when you built the batch or you need more than five dilutions for the
sample.

5.8 ADD A SAMPLE TO THE BATCH

Click the NEW SAMPLE button to add a new sample into the batch.  You may need
to add a sample if you forgot to add the sample when you built the batch.  The
following form is displayed:
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Select the sample to add from the list and the number of dilutions and the dilution volumes will
be read from the sample setup.  Edit the Sample’s dilutions and Seeding information if required
and click OK.  Changing the dilution and seeding information on this form only changes it for
this batch.  The sample and its bottles will be added to the end of the batch.

5.9 MARKING A BOTTLE

This button marks tests independently of the current criteria. If a test is marked, it is
not used in the final BOD calculation. The ability to mark or unmark records enables the user to
make judgement calls in selecting or rejecting BODs.  Tests are automatically marked as
unacceptable when data is changed.  To manually mark a test that meets the current criteria, move
the cursor to the row and select the MARK button.  The test will be removed from the final BOD
calculation

5.10 UNMARKING A BOTTLE

Removes the marked condition for the current row.  If the current row is marked
(manually or automatically) the UNMARK button adds the test back into the final
BOD Calculation.

5.11 CHECK CRITERIA

Calculates the BODs and checks the criteria for all bottles.  Marks bottles that do
not meet criteria.  Please note: if the Apply criteria after Finals on the Criteria
Setup form has a check mark, the criteria will automatically be applied.   If you
want to check the criteria manually at any time, click this button.

5.12 FIELD DESCRIPTIONS

Sample Date: Enter the sample date.  When the sample date is entered, any previous entries are
retrieved.

Incubation Period: The date range of the BOD incubation period.  The start date of the
incubation period is set when Initial DOs are read.  The end date is set when finals are read.

Seed Correction: Shows the amount of seed correction in mg/l DO per ml of seed used.  All
samples that are set as Use as Seed in sample setup that are in the batch will be listed.  As you
move in the bench sheet the current Seed will be highlighted.  For example if your Effluent
sample is seeded with Influent, when the cursor is moved to the Effluent sample, the Influent
Seed Correction factor in the list will be highlighted.

Technician: Used to identify the person responsible for the validity of laboratory test data. Up to
twenty-five characters can be used to indicate the employee's social security number, name or
initials.
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Notes: Used for any miscellaneous notes for the entire batch.

Bottle Notes: This field allows entry of bottle specific notes.  As the cursor is moved around the
bench sheet the notes for the current bottle will be displayed.  This allows users to enter the pH of
the bottle if it is required by the state.

5.13 COLUMN DESCRIPTIONS

Sample Name: Identifies the sample.

Bot tle #: The number of the BOD bottle used for incubation.

Pre Dil: The pre-dilution ratio for the bottle. Very strong samples sometimes require dilutions
that would be difficult to make in one step.  In these cases, a sizeable quantity of sample is first
diluted to a ratio that will make the final dilutions practical. Sometimes a pre-dilution is called a
serial dilution. In the BOD Analyst software, we call this ratio the pre-dilution.  For example, if
you add 10 ml of your dairy farm sample to a 1000 ml volumetric flask and then fill the flask with
dilution water, enter 100 (1000/10) for the Pre Dil ratio. The Pre Dil ratio defaults to 1. This
column appears only if the “Do you predilute your bottles?” field in General Setup is checked.

Samp Volume (ml or %): The sample volume in milliliters or % in the BOD bottle. Use the
Dilution Unit field in General Setup to choose whether to enter this number in ml or %.

Seed Volume (ml): The seed volume in milliliters introduced into the BOD bottle.  If the field is
left blank, Seed Vol defaults to zero.

Init DO (mg/l): The amount of dissolved oxygen at the beginning of the incubation period
measured in milligrams per liter.

Final DO (mg/l): The amount of dissolved oxygen at the end of the incubation period measured
in milligrams per liter.

O2 Depl (mg/l): The amount of dissolved oxygen as mg/l consumed during the incubation period.
If blank compensation is turned on, the depletion calculation will remove the depletion due to the
Blank Water.   This field is automatically calculated:

= (NormFactor * (InitDO – FinalDO)) - (BlankComp per ml * Blank Water in Sample)

Seed Factor (mg/l): Used to correct the BOD test for oxygen depletion resulting from the
presence of seed.  Seed correction per ml is derived from seed control tests, then multiplied by the
amount of seed used in the test, as shown below.  If there is no seed used in the test the seed
factor is zero.  The seed factor will also be shown as zero if all seed tests are marked as
unacceptable.  This can produce invalid results for tests that use seed.
   

Seed Factor  =  Seed Correction per ml  *  Seed Vol  

BOD (mg/l): The calculated BOD for the bottle.

Final BOD (mg/l): Calculated by averaging the BODs of all dilutions for a sample that have not
been marked as unacceptable.
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5.14 DELETING A BOTTLE

To remove a bottle from a batch, click on the
row header and press the delete [del] key.  To
select multiple bottles for deletion, click on
the row header and drag the mouse to
highlight multiple rows.  With the rows
highlighted, press DELETE and all the
highlighted rows will be removed from the
batch.  The DilBlank Sample cannot be
deleted from a batch.



SECTION 6 TAKING INITIAL DO READINGS

6.1 ENTERING BOTTLE NUMBERS

6.1.1 USING THE YSI 5000/5100 DO INSTRUMENT

Just after selecting Read / Initials from the menu, the YSI 5000/5100 DO Instrument display will
look like this:

To begin taking measurements, press CONFIRM.  You will then move onto the bottle number
prompt for either the first bottle in a new Batch, or the next bottle to be done in an interrupted
Batch.  Here is the bottle number prompt for an Effluent Sample.

The top line of the display will show the Sample name and dilution of the next bottle to be read.
There will also be an "i," in the top line indicating that you are working on initial DOs.  There
will be a prompt for the bottle number in the bottom line.  After you enter the bottle number, the
program will display the DO as follows.  This data will also be displayed on the Read YSI form.

You can enter bottle numbers one digit at a time using the up and down arrow keys, pressing
CONFIRM after each digit.  One and two digit bottle numbers need leading zeros. (Enter "007,"
not "7.")  Since each digit starts at 0, it is easier to enter a "7" by pressing the down key three
times.  To enter the bottle number, 294, enter "2" for the first digit. Press the up arrow key twice,

then press CONFIRM.

To enter "9" for the second digit, press the down arrow key once,

Begin taking
Initials?

Effluent 60 i
Enter bot#2

Effluent 60 i
Enter bot#20

Effluent 60 i
Enter bot#0

Effluent 60 i
7.74 mg/L B#551
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then press CONFIRM.

To enter "4" for the last digit, press the up arrow 4 times, then CONFIRM.   The SKIP button is
used like backspace during bottle number entry.  Before pressing CONFIRM on the last digit,
pressing SKIP will move you to the previous digit so you can change it with the UP and DOWN
button.  After the last digit of the bottle number is entered, the program will continue reading
dissolved oxygen.

When the reading is stable, press CONFIRM.  The program will store the reading, display a brief
message and then prompt for the next bottle number.

All the pertinent information is on the YSI 5000/5100 DO Instrument display.  The top line of the
display has remained the same.  The DO reading and the bottle number are in the bottom line.
This will help you keep track of where you are in the Batch.  When the DO reading is stable,
press CONFIRM. The program will store the reading and then go on to the bottle number prompt
for the next bottle in the Batch.  Typically, you will start with the first bottle in the Batch and
continue all the way through the Batch, entering bottle numbers and storing DO readings in turn.
As you go along the bottle numbers and DO readings will be added to the Bench Sheet.  Below is
an example of this screen about halfway through a Batch.

Effluent 60 i
Enter bot#29

Effluent 60 i
Enter bot#290

Effluent 60 i
8.36 mg/L B#295
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You can also move between dilutions (bottles) without going through the batch sequentially.  The
SKIP, UP, and DOWN buttons can be used to navigate through the batch.

SKIP Moves to the next bottle (dilution).

UP Moves to the first dilution of the previous sample

DOWN Moves to the first dilution of the next sample

Note: The SKIP, UP, and DOWN buttons provide different functions when entering bottle
numbers and will NOT move to a different dilution.

When you have finished all of the bottles in a Batch, the program will display the following on
the YSI 5100 DO Instrument :

You will then be returned to the Bench Sheet.

6.1.2 USING THE BARCODE WAND

The barcode wand can ONLY be used with the YSI 5100 DO instrument. You can choose one of
two ways to use the barcode wand.  If the Barcode reader field on the YSI Instrument
Parameters Form is set to required, then the program will require barcode bottle number entry
during both initial and final DOs.  Furthermore, the program will not accept bottle numbers from
the YSI 5100 DO Instrument keys or from the PC keyboard.  If the Barcode reader field on the
General Setup Form is set to on, then the program will ask for bottle numbers only during initials
and will accept bottle numbers from the YSI 5100 DO Instrument keys and the PC keyboard.  See
Bar Coding in the Section 11, Customizing Your Program.

If you want to use the barcode wand for initials only, then be sure to set the Barcode reader field
on the YSI Instrument Parameters Form to on.  The program will prompt for bottle numbers in
the same way as described in “Entering Bottle Numbers With the YSI 5100 DO Instrument
Keys.”  When you see the "Enter bot #0" prompt, scan the label on the bottle and the program
will accept the barcode input and then go on to reading DO.  The program will also accept input
from either the YSI 5100 DO Instrument or the PC keyboard.

If you want to require that the barcode wand be used for both initials and finals, then be sure to
set the Barcode reader field on the YSI Instrument Parameters Form to required.  The program
will prompt for bottle numbers in this way for initials:

During final DOs, the program will use the bottle number that was entered during initials in the
prompt, as follows:

Effluent 60 i
Scan bottle

Effluent 60 f
Scan bottle# 551

Initial Reads
Complete
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You do not have to do the final DOs in the same order as you did the initials.  If want to do some
other bottle number than the one for which the prompt appears, simply scan that other bottle, and
the program will jump to that bottle in the Batch.

6.1.3 USING A PC KEYBOARD

You can use the PC keyboard to enter the bottle numbers on the benchsheet before beginning
initial readings, or use the keyboard to enter the bottle numbers as you work. You may use the
number keys on your PC any time you see the "Enter bot #0**" prompt on the YSI 5000/5100
DO Instrument.  Type in a three-digit number and click CONFIRM.  The program will accept the
bottle number and go on to reading DO.  Remember that one and two digit bottle numbers need
leading zeros. (Enter "007", not "7.")

In fact, you can use the PC keyboard for all YSI 5000/5100 DO Instrument key inputs.  The
buttons displayed on the Read YSI form correspond to the keys on the YSI 5000/5100 DO
Instrument.

6.1.4 DUPLICATE BOTTLE NUMBERS

Occasionally it is necessary to have two or more bottles with the same bottle number.  This will
not cause any trouble as long as you can keep them straight.  The program will warn you before
accepting a repeated bottle number.

If you really intend to have a duplicate bottle number, then press CONFIRM.  If not, press SKIP
and the program will take you back to bottle entry.

6.2 AUTO STABILIZATION

Let's suppose that you have set the Technique: field on the YSI Instrument Parameters Form to
manual.  When you are reading DO and the reading meets your stabilization criteria (also set on
the YSI Instrument Parameters Form), the program will notify you that the reading is stable as
follows.

If a change in the reading is greater than the stability criteria, then the "STBL" display will go
away.  With Technique set to manual, the program will store the reading whenever you press
CONFIRM, whether the reading is stable or not.  If instead, you set the Technique: field to dual,
the program will wait to store the reading until both the reading is stable and you've pressed
CONFIRM.  The order is not important.  If the reading is stable before you press CONFIRM,
then you will see the "STBL" display above until you press CONFIRM.  If you press CONFIRM
before the reading is stable, then the program will store the reading as soon as it becomes stable.

Effluent 60 f
Another B#551?

Effluent 60 i
7.74 STBL B#551
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The fastest and easiest way is to set Technique: to auto.  After the bottle number is entered the
program will store the reading as soon as it is stable.  Entering the bottle number then, is an
implied confirmation of the soon to be stable reading.

6.3 ALARMS

Alarms are provided for temperature and supersaturation.

You can specify a range of temperatures for initial DOs and a different range of temperatures for
final DOs.  Just before storing a reading the program will check the temperature.  If it is outside
the range, then the program will display a warning message on the YSI 5100 DO Instrument, for
example

If you do not want to store the reading, press SKIP and you can take steps to remedy the situation.
If you want to store the reading anyway press CONFIRM.

It is common to collect a sample in cold weather that is over 10 mg/L.  While a 10 mg/L sample
is not supersaturated at low temperatures, it is at 20 °C.  If such a sample is placed in the
incubator, it is likely that it will outgas and cause erroneously high BOD.  The supersaturation
alarm will warn you that the reading is above the value that you have specified.  It indicates that
there is a risk of supersaturation.  The warning is as follows:

If you do not want to store the reading, press SKIP and you can take steps to remedy the situation.
If you want to store the reading anyway press CONFIRM.

All of the alarm settings are on The YSI Instrument Parameters Form.  See Section 11.5 for
detailed instructions.

6.4 DERIVED INITIAL DOS

If you have checked the Derive initials field on the General Setup Form, then the program will
automatically derive initial DOs for you whenever it can.  You can always write over a derived
initial DO by simply storing a measured reading to that bottle.  Let's go back to the batch that we
were working with and let's start just after we've stored our blanks.

Temp 24.3 high
Store anyway?

Supersaturated
Store anyway?
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Now, we will want to measure only one of the dilutions of the Influent Sample and derive the
other two.  There is less experimental error if you measure the strongest dilution.  You will have
to enter bottle numbers for all three dilutions.  So, you will enter the bottle number for the first
dilution, SKIP past its DO reading, enter the bottle number for the second dilution, SKIP past its
DO reading, enter the bottle number for the third dilution, and finally store a DO reading.  After
initials are complete, the remaining initials that have not been read will be derived.  In our
example, the 6 and 12 ml Influent dilutions were derived (8.53 and 8.58).

You can proceed through the rest of the batch measuring DOs for only the strongest dilutions for
each Sample.
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You don't have to derive initial DOs for every Sample in the Batch.  For instance, you may derive
initials for only those Samples that are not required by your NPDES permit.  All you need to do is
skip all those dilutions that you want to be derived and measure all the dilutions that you don't
want derived.

You can measure more than one of the dilutions for any Sample.  The program will use the
average of the measured dilutions in deriving the initial DOs for any remaining dilutions.

In deriving initial DOs, the program considers all of the constituents of a bottle.  For example, the
Sample, Clarifier, has only two constituents, the undiluted sample collected from the clarifier,
and dilution water.

6.5 CORRECTING MISTAKES

If you have finished reading the initial DOs and notice mistakes use the bench sheet to correct the
mistakes.  The bench sheet allows you to correct most mistakes by simply moving to the field and
editing the data.  You can change the Bottle Number, Sample Volume, Seed Volume and Initial
DO providing it is still the same day that Initials were taken.

You can also retake all the readings or one bottle.  Select Read / Retake Initials and choose
either All bottles or This bottle from the menu.  All bottles will start at the beginning of the
batch and retake each bottle.  This bottle will only read the current bottle.  The current cell in the
bench sheet sets the current bottle.  In the example below, Influent sample bottle #229 is the
current bottle.



SECTION 7 TAKING FINAL DO READINGS

7.1 SELECTING A BATCH

From the main bench sheet window, simply enter the sample date for the batch you would like to
take readings for. Alternatively, click the List Open Batches button (See Section 5.2, Loading a
Batch for more information) to select a batch that is not yet complete.  The batch will be
displayed.  Below is an example of a batch ready for final DOs to be read.

7.2 AT THE YSI 5100 DO INSTRUMENT

Select Read/Finals from the BOD Analyst software Main Menu.  The  YSI 5000/5100 DO
Instrument display will look like this:

To begin taking measurements, press CONFIRM.  A typical display during finals would be:

Begin taking
finals?

Effluent 60 f
1.58 mg/L B#551
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Your Technique for Auto Stabilize setting affects how the BOD Analyst software responds to
your input.

Auto: The YSI 5000/5100 DO Instrument will automatically store the DO
reading when the reading becomes stable.

Dual: After the reading is stable, press CONFIRM to store the reading.

Manual: Press CONFIRM to transfer the current DO reading from the YSI
5000/5100 DO Instrument.  The YSI 5000/5100 DO Instrument will
display STBL when the reading becomes stable.

None: Press CONFIRM to store the current reading.  The YSI 5000/5100 DO
Instrument will not display STBL.

There is very little difference between taking final DOs and taking initials.  The YSI 5000/5100
DO Instrument menu is the same.  The "i" in the display has been replaced with an "f".  The
alarms work in exactly the same way.

Pressing CONFIRM will start the auto-stabilization routine.  Otherwise, autostabilization works
the same way for final DOs as it does for initials.  Alarms and the YSI 5000/5100 DO Instrument
menu work in the same way as for initial DOs.  See Section 6, Taking Initial DOs for a detailed
explanation of The YSI 5000/5100 DO Instrument menu, alarms, and auto-stabilization.

The BOD for each bottle (dilution) and Sample is calculated as you go along.  However, the
calculations for some Samples depend on the results of others.  For example, one cannot calculate
the BOD of a seeded sample until the final DO for the seed has been performed.

If you need to correct a final DO reading that has been stored, you can retake final DO readings
just as you were able to do for initial DOs.  To do this, load the batch into the bench sheet and
select Read / Retake Final.  An example of the bench sheet Screen after completing finals is
shown below.
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7.3 CORRECTING MISTAKES

If you have finished reading the final DOs and notice mistakes, you can use the bench sheet to
correct the mistakes just as you did with the initials.  The bench sheet allows you to correct the
Final DO providing that the incubation period is between 4 and 7 days. You can also retake all
the readings or one bottle.  Select Read / Retake Finals and choose either All bottles or This
bottle from the menu.  All bottles will start at the beginning of the batch and retake each bottle.
This bottle will only read the current bottle.  The current cell in the bench sheet sets the current
bottle.



SECTION 8 REPORTS

Under the File menu, you will find the Print Daily Bench Sheet and Print Everything Report
options. The Print Daily Bench Sheet will print your bench sheet data for the batch you have
selected. The Print Everything Report will print all data for the selected batch.

To open a sample report, select Open from the File menu. Open the Data folder, and highlight
the Sample. mdb file and choose OK. In the Trending menu, choose Report, and then select
Design. Under the File menu, choose Open and then the file called Sample Monthly Report.
Opening this file will display a sample report pictured below. If no data is displayed in the report,
under the File menu, select Report dates. Change the start date to 01/01/99, and the end date to
01/31/99 and choose OK. The sample report will look similar to the screen below.
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8.1 REPORT DESIGN

The report designer is used to setup spreadsheet type reports.  Daily values and monthly summary
values from BOD Analyst software samples can be placed into the spreadsheet.  After placement,
normal spreadsheet formulas can be used to calculate sums, averages, etc. of the placed BOD
Analyst software data. Formatting of the report is done through familiar spreadsheet functions to
change fonts, borders and cell colors, etc.

8.1.1 USING REPORT DESIGN

Report design works very much like a basic spreadsheet program.  Move to a cell and enter the
text, numeric data, or a formula in the cell.  The menu allows you to save, retrieve, print, format,
etc. the spreadsheet in any manner you like.

Use the Locate menu option to place BOD Analyst software data into the spreadsheet.
Locate/Sample places daily values for a selected sample in the spreadsheet at the current cell.
When the report date range is changed the data is automatically updated to reflect the new date
range.

8.1.2 SPREADSHEET NAVIGATION

Primarily, the mouse is used to move around the spreadsheet.  To move to a cell (i.e. make it the
active cell) simply click on that cell.  To select a block of cells, click on a cell and drag the mouse
to select multiple cells (selected cells appear in black).  With a block of cells selected, you can
then change the font, border, color, etc. of all selected cells with a single command.

The following table displays the keystrokes used to move in the spreadsheet.
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Key Action
Up Arrow Move up one row

Down Arrow Move down one row

Right Arrow Move right one column

Left Arrow Move left one column

Shift+arrow key Extends selection in direction of arrow key

PgUp Move one page up

PgDown Move one page down

Ctrl+PgUp Move one page left

Ctrl+PgDown Move one page right

Home Move to first cell in the current row

End Move to the last cell in the current row with data

Ctrl+Home Move to cell A1 (upper left corner of spreadsheet)

Ctrl+End Move to last row and last column that contains data

Shift+Space Selects current row

Ctrl+Space Selects current column

Enter Move right one column

8.1.3 RESIZING COLUMNS AND ROWS

To resize a column, move the mouse pointer between the columns as shown below.  The mouse
pointer will change and you can then drag the mouse left to shrink the column or right to enlarge
the column.  To adjust the row height, move the mouse pointer between the row headers.  The
mouse pointer will change and you can then drag the mouse down to enlarge the row or up to
shrink the row.
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Note: To resize multiple columns at one time, select all the columns by clicking and dragging
the mouse on the column headers.  With the columns selected, resize one of the selected columns
and all the selected columns will be sized the same.  The same method can be used to resize
multiple rows at one time.

8.1.4 COPYING DATA

You can copy data to and from cells using the familiar Clipboard method.  Also, you can drag and
drop data to copy a selected block of cells.  The method you use determines whether only the data
or all of the data, formulas and formatting characteristics are copied.

When you copy data from one cell to another, the data from the cell you copied replaces the data
in the cell you are pasting into.  For example, if cell A1 contains the value 4, if you copy and
paste it into cell B3, the contents of cell B3 are replaced by the value 4.  The same applies when
copying a block of cells.

To copy format (cell color, border, justification, etc), formulas and data:
Select the cells you want to copy with the mouse.
Press and hold down the CTRL key
Position the mouse pointer over the edge of the selection so that the arrow pointer appears.
Press the left mouse button and drag the cells.
Release the left mouse button when the pointer is over the new location for the copied cells.

To copy only data:
Select the cells you want to copy with the mouse.
Press CTRL-C (or select Edit/Copy from the menu) to copy data to the clipboard.
Click on the destination cell and press CTRL-V (or select Edit/Paste) to paste data from the
clipboard.

8.1.5 MOVING DATA

You can move data to and from cells using the familiar cut and paste Clipboard method.  Also,
you can drag and drop data to move a selected block of cells.  The method you use determines
whether only the data or all of the data, formulas and formatting characteristics are copied.

To move format (cell color, border, justification, etc), formulas and data:

Select the cells you want to copy with the mouse.
1. Position the mouse pointer over the edge of the selection so that the arrow pointer appears.
2. Press the left mouse button and drag the cells.
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3. Release the left mouse button when the pointer is over the new location for the copied cells.

To move only data:
1. Select the cells you want to move with the mouse.
2. Press CTRL-X (or select Edit/Cut from the menu) to cut data to the clipboard.
3. Click on the destination cell and press CTRL-V (or select Edit/Paste) to paste data from the
      clipboard.

8.1.6 USING FORMULAS

You can define formulas (math expressions) for cells.  The formulas can use cell references to
calculate values depending on the contents of other cells.  To enter a formula for the current cell,
simply click on the formula textbox and enter the formula.

To refer to other cells in formulas type in the column header Letter and then the row number.  For
example, to refer to the cell that is in the first column (A) and the first row (1) use A1'.  The
second column, second row is referred to as B2.  To refer to a block of cells, use the start cell then
the colon : then the stop cell.  For example, to refer to cells A1, A2, A3, and A4 enter A1:A4.
The following screen illustrates cell references.

The following table lists the operations available as math expressions.

Operator Description Example
+ Addition A1 + B2
- Subtraction A1 - B2
^ Exponentiation A1 ^ B2
* Multiplication A1 * B2
/ Division A1 / B2
& Logical And A1 & B2
| Logical Or A1 |  B2
: Creates a range A1: B2

8.1.7 FUNCTIONS IN FORMULAS

General Functions



Reports Section 8

YSI Incorporated BOD Analyst for Windows Software 38

ABS(A1) The absolute value of the cell is returned.

ISEMPTY(A1)If A1 is empty then a 1 is returned. If A1 is not empty then a zero is returned.

MAX(A1:A31) Returns the maximum value for the cell range.

MIN(A1:A31) Returns the minimum value for the cell range

NEG(A1) Changes the sign of the value. For example, NEG (-15) = 15.

NOT(A1) If A1 is zero then a 1 is returned. If A1 is not zero then a zero is returned.

SUM(A1:A31) Returns the total for the cell range

GMEAN(A1:A31) Returns the Geometric Mean for the cell range.  Values of 0 are ignored.

COUNT(A1:A31) Returns the total the number of values for the cell range

8.1.7 IF STATEMENTS

As in any spreadsheet program, IF Statements may be entered as formulas.  The syntax is simply:

IF(Condition, TrueResult, FalseResult)

Condition is the test which will be either true of false, TrueResult is the expression which
determines what to display if the Condition is True, and FalseResult is the expression which
determines what will be displayed if the Condition is False. For example, consider the following
statement:

IF(D5>120,E5,F5)

This statement says “if the value in cell D5 is greater than 120, then display the value in cell E5,
otherwise (else), display the value of cell F5”.

TrueResult and FalseResult may be cell references, numeric values, numeric expressions
(calculations) or other IF Statements.  Cell references may be anchored using the dollar sign ( $ ).

8.1.8 BOD ANALYST SOFTWARE FUNCTIONS

The following functions are those used by BOD Analyst software when statistical information or
dates are located in the spreadsheet.  They are explained here in detail for clarification and to
allow advanced users to perform less typical analyses or to make modifications to formulas
placed by BOD Analyst software.

VAR(VarNum, Offset, future, future, future, future, future)
Returns the daily value for a sample.  This formula is automatically built when
Locate/Sample is used.

VarNum  The sample number.
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Offset  The offset from the start date of the report.  For example, if the start date is 1/1/99
and the offset is 1, the value from 1/1/99 will be returned.  If the offset is 2, the value
from 1/2/99 will be returned and so forth.

Future OPTIONAL, Not Used.

VARWO(VarNum, Offset, future, future, future, future, future)
Returns the daily value for a sample when data is found.  See Print Data only when it
occurs example in Locating Data on the Report later in this section. This formula is
automatically built when Locate/Sample is used.

VarNum The sample number.

Offset  The offset from the start date of the report.  For example, if the start date is 1/1/99
and the offset is 1, the value from 1/1/99 will be returned.  If the offset is 2, the value
from 1/2/99 will be returned and so forth.

Future OPTIONAL.  Not Used.

DATE(Offset, Format, Interval)

Returns a date.   The easy way to place this function is to use Locate/Date.

Offset Sets the number of intervals from the start date of the report

Format Format for the date.  Common formats:
 mm/dd/yy 01/01/99

mmm Jan
mmm yyyy Jan 1999

Interval The interval of time used with the Offset to calculate the date to print.
Values are:

 1 Days
-1 Print the end date of the report
 3 Months
 4 Current Date

DWO(VarNum, Offset, FormatStr)
Returns a date only when data occurs for the sample specified by VarNum.

VarNum The sample to search to decide what day to print for.

Offset Sets the number of days from the start date of the report

FormatStr Format for the date.  Common formats:
mm/dd/yy 01/01/99
mmm Jan
mmm yyyy Jan 1999
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8.1.9 MONTHLY FUNCTIONS

Monthly functions return summary values for a sample for a specified month.  The VarNum
parameter sets the sample to be used.  The Offset sets the month to be retrieved relative to the
specified report start date.  For example, with a report start date of 1/1/99, in Offset of 1 would
define January, 2 February, etc..   The easy way to place these functions is to use
Locate/Monthly Summary.

MSUM(VarNum, Offset)
Return the Monthly total for the sample.

MAVG(VarNum, Offset)
Return the Monthly Average for the sample.

MMAX(VarNum, Offset)
Returns the monthly maximum for the sample.

MMIN(VarNum, Offset)
Returns the monthly minimum for the sample.

MDEV(VarNum, Offset)
Returns the standard deviation of the data in the specified month.

MAOT(VarNum, Offset)

Returns the �average over time” which totals the data for the month and divides by the number
of days in month instead of the number of values found.  For example, if you enter rainfall only
on days it occurs and leave other days blank, MAOT will give you the average rainfall per day.
MAVG would give you the average rainfall for days that it rained.

MGMN(VarNum, Offset)
Returns the geometric mean of the values for the specified sample found for the
month.

MNOS(VarNum, Offset)
Returns the number of samples found for the month for the sample.

8.1.10 WORKING WITH REPORT FILES

In the File menu you will find standard functions such as: New, Open, Save, Save As, Print,
Page Setup, Exit.  You will also find an item for deleting reports.

Select File, New to clear an open document from the screen and open a new document.  If an
open document has been modified the user will be asked if changes are to be saved prior to
closing the file and removing it from the screen.  The following form appears allowing selection
of a template to start the new spreadsheet.
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The    ‘<<< Blank Report >>> selection loads a completely blank file.  The other selections load a
spreadsheet file to start your new document with.  For example, choosing Custbill.ss2 will load a
file with all the text, borders, and statistics setup for creating a bill for a customer.  Use Locate,
Sample to place your data in the report and the report is complete.

To add a template to the list, simply copy the “SS2" file from your data directory to the BOD
Analyst software directory.  For example, if you have a spreadsheet you want to add as a
template, simply find it’s filename (i.e. “4.SS2") and copy it to the BOD ANALYST
SOFTWARE directory.  That spreadsheet will then appear on the template list.

File, Open closes the current spreadsheet and opens an existing spreadsheet.   When Open is
selected the user is presented with a list of previously created reports.  This list displays the report
titles, not a list of the file names.  Select the title of the report you want to open with a single
click, then click OK.  Double clicking on a report title will also open the report.

Save the open report document by selecting File, Save.  If the report is currently Untitled the user
will be prompted to enter a report title of up to 50 characters.

Save As . . .  saves the open report document but preserves the document originally opened.
When Save As is selected the user is automatically prompted for a new report title.  Save As can
be used to copy an existing report.  Simply open the report to be copied then select Save As to
rename it with a new title. The Original report file is closed thus preserving it from any
modifications made to the new report.

To delete an existing report select File, Delete .  The user is presented with a list of existing
report titles.  Highlight the title of the report to be deleted and click OK.  Double clicking on a
report title will also delete the report.

The Report Dates item on the File menu changes the report date range while designing the
report.

Select Print from the File menu to print the open report.  Selecting Print will open the print
options dialog where the user selects what to print and can enter new start and end dates for the
report.  The report will automatically re-calculate immediately prior to printing.

Click Exit on the File menu to close the open report document and exit report design. If an open
document has been modified the user will be asked if changes are to be saved prior to exiting.
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8.2 EDIT MENU FUNCTIONS

To cut numbers, data values or text within the currently selected cells to the clipboard, use Cut
from the Edit menu.  Formulas and format settings will NOT be cut.  Data values that have been
cut from cells containing formulas will reappear the next time the spreadsheet calculates itself.  In
order to remove formulas along with their resulting values or to reset cell formatting, use Clear
on the Edit menu instead of Cut.  See Copying Data and Moving Data for more information.

Use Copy to copy currently selected numbers, results of functions (data values) and text to the
clipboard.  Formulas and formatting will NOT be copied. In order to copy formulas along with
their resulting values or to copy cell formatting, use the method explained in Copying Data and
Moving Data.

Paste places items in the clipboard to the current cell.  If the data in the clipboard originated in a
range of cells, it will be pasted in a similar range of cells.  For example, if text was copied from
three rows and two columns, it will be pasted into three rows and two columns using the currently
selected cell as the upper left-hand corner.

Edit, Clear removes all data, formulas, and formatting from the currently selected cells.

To force the report to recalculate, select Calculate from the Edit menu.  Calculation of the report
occurs automatically when the report is opened or saved, after a formula is entered or edited and
immediately prior to printing.

Formulas may be edited in a number of ways.  First select the cell with the formula to be edited.
Then do one of the following:

•  Click the mouse pointer into the Formula Edit Box.
•  Select Formula on the Edit menu.
•  Press the F4 function key.

Edit the formula as needed.

Insert Row inserts an entire row above the current cell.  All formulas are automatically adjusted.

Insert Column inserts an entire column before (to the left of) the current cell.  All formulas are
automatically adjusted.

Use Edit, Delete Row to delete the current row and Edit, Delete Column to delete the current
column.

8.3 LOCATING DATA ON THE REPORT

8.3.1 LOCATING DAILY DATA

Locate, Sample is used to place daily sample values on the spreadsheet.  It builds a formula that
the spreadsheet uses during calculations to retrieve data from the BOD Analyst software database.
It places the column starting at the current cell.  When Locate, Sample is selected the following
dialog appears:
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The Locate Sample Formula dialog can also be opened by clicking on the Locate Sample button,

.  The fields on the Locate Sample Formula form are as follows:

Sample:  Select the sample to locate.

Decimal Places: The number of digits to show behind the decimal point.

Print Data only when it occurs: Skips days with no data.  The example below illustrates
how to use this field.

Place Date beside data: Places the corresponding date in the column next to the located
data.

Date Format: Sets the format (i.e. 12/31/99, Dec 31, etc.) for the date column.

Place Data Across: Locates data horizontally in a row.
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Sample Name: Check the sample name box to have the sample name appear as a column
heading.

Units: Check the units name box to display the units as a column heading.

Display XX values: Sets the number of values to be placed.

8.3.2  LOCATING WEEKLY SUMMARY DATA VALUES

Locate, Weekly Summary is used to place one or a series of weekly summary statistics on the
spreadsheet.  It builds a formula that the spreadsheet uses during calculations to retrieve data from
the BOD Analyst software database.  It places the values starting at the current cell.

The fields on the Locate Weekly Stat window are:

Sample Name: Select the name of the sample to use.

Statistic: Choose the statistic to be calculated from the daily sample values.

Locate Statistic for [XX] Weeks: Enter the number of weeks you want the statistic to be
calculated.  The first week will be calculated beginning on the Start Date of the report
and ending on the last day of the week as defined in the Week Definition.  Each week
thereafter will follow the Week Definition.
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Display [X] Decimal Places: Enter the number of digits to be displayed after the decimal
point.

Week Definition: Select the way weeks are to be divided.

8.3.3 LOCATING MONTHLY SUMMARY DATA VALUES

Locate, Monthly Summary is used to place one or a series of monthly summary statistics on the
spreadsheet.  It builds a formula that the spreadsheet uses during calculations to retrieve data from
the BOD Analyst software database.  Values are placed starting at the current cell.

Sample: Select the sample to summarize.

Statistic: Sets the summary statistic to use.

Locate Statistic for [XX] Months: Sets the number of values to place.  For example, to
place 12 monthly averages, enter 12.

Decimal Places: The number of digits to show behind the decimal point.

8.3.4 LOCATING REPORT SUMMARY DATA VALUES

Locate/Report Summary is used to place a summary statistics on the spreadsheet.  The statistic
specified is calculated using all values found from the Start Date to the End Date of the report.  It
builds a formula that the spreadsheet uses during calculations to retrieve data from the BOD
Analyst software database.

Sample: Select the sample to summarize.
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Statistic: Sets the summary statistic to use.

Decimal Places: The number of digits to show behind the decimal point.

8.3.4 LOCATING DATES ON THE REPORT

As well as placing dates along side data values while using Locate, Sample, formulas for dates
can be located on the report using the Locate, Date feature.  This feature offers a wider range of
formatting choices in that the dates can be placed weekly and monthly as well as daily.  Formulas
that result in displaying the Start Date, End Date and the Current Date are also available choices.

[XX] Consecutive Dates: Places the specified number of consecutive dates on the
spreadsheet beginning on the start date of the report.

[XX] Consecutive Months: Places the specified number of consecutive months (the first
of each month) on the spreadsheet.

[XX] Consecutive Weeks: Places the specified number of consecutive weeks (the last
day of each week as specified in the Define Week field) on the spreadsheet.

Start Date: Places the start date of the report in the current cell.

End Date: Places the end date of the report in the current cell.

Current Date: Places the current date in the selected cell.

Date Format: Select the format in which to display the specified dates.

Define Week: Specify the beginning and ending days of the week.
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8.4 FORMATTING CELLS

The BOD Analyst software Report Designer offers great flexibility in formatting cells.  All
formatting is accomplished using the items on the Format menu.  This menu also provides for
the insertion of page breaks.

Format, Font opens the font dialog with which font settings can be changed for the current cell
or an entire block of cells.  Settings for font color are ignored here.  The background color and
foreground color (font color) are set using Format, Cell Colors.

To toggle the cell type between text and numeric, use Format, Cell.  When OK is selected on the
Format Cell dialog, the settings are applied to all selected cells. If Text is selected as the Cell
Type, checking the Multiline Edit box causes text to wrap to multiple lines in a single cell as
shown in the example below.  The row height must be able to accommodate the number of rows
required if multiline edit is selected. With Mulitiline Edit off, text overlaps to the cell to the right
if that cell is empty.

Borders can be specified by choosing Borders from the Format menu.  Select which borders are
to be drawn for the selected cell or group of cells and click the OK button.

Note:  Borders and the grid are not the same thing.  The grid cannot be changed and is not
printed. Borders are always printed.

Cell Colors are changed using the Cell Colors item of the Format menu.  Set the background or
foreground color by clicking the appropriate SET COLOR button.  An example of the new
settings is presented at the bottom of the dialog.

Page breaks are added and deleted using the Format menu.  Row Page Break, Add sets a page
break on the current row. When printing the spreadsheet, the row containing the page break is the
first row printed on the new page.  The row header of the row containing the page break will have
a red border. Row Page Break, Remove removes an existing row page break.  You must move to
the row containing the page break to remove it.  Col Page Break, Add sets a page break at the
current column.  When printing the spreadsheet, the column containing the page break is the first
column printed on the next page.  The column header of the column containing the page break
will have a red border. Col Page Break, Remove removes a column page break.  You must move
to the column containing the page break to remove it.
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8.5 OBTAINING HELP WHILE DESIGNING REPORTS

The help menu provides access to context sensitive help while designing a report.  The help
system can also be activated by simply pressing the F1 function key.

8.6 PRINTING REPORTS

Trend reports may be printed without entering the report design mode by selecting Report, Print
from the Trending menu.  This functionality allows the user to select multiple reports to be
printed in a batch print job.  Simply click on the titles of the reports you want to print, set the
Start Date and the End Date and click the OK button.  A message saying “Finished printing
selected reports” will appear after all of the reports have been sent to the printer.  Printer settings
may be changed using the SETUP PRINTER button.



SECTION 9 KEEPING YOUR DATA SAFE

9.1 DATE

The BOD Analyst software depends on the correct date to do its calculations and manage the
data.  The current date on your computer is displayed in the upper right hand corner of BOD
Analyst software.  If the date is incorrect, exit BOD Analyst software and correct the date in
windows (click on the Date/Time icon in the Control Panel).

9.2 HARDCOPIES

No computer is perfect, and once in a great while, a failure will cause data to be lost.  You will
probably want to keep a paper copy of your work at all times.  When you are finished taking
initial and/or final DOs, select File/Print Daily Bench Sheet.

9.3 UNDERSTANDING DATA FILES

Data is stored in a Microsoft Access database.  The default database name is data.mdb.   When
you start BOD Analyst software, the data.mdb database is automatically opened.    It is stored in
the data subdirectory under the BODAW directory (if BOD Analyst software was installed to the
default directory).  The current database is shown in parentheses on the Application Title Bar.

BOD Analyst software allows you to have any number of databases, but you can only have one
opened at a time.  You may need multiple databases to track BODs from more than one facility or
you need to run tests on the same day for different incubation periods.

To create a new database, select File, New and the following form will be displayed.

Enter in a file name for the new database.  The filename must follow DOS naming conventions (8
character maximum, cannot contain special characters, etc…).  Click OK and the new database
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will be created and opened.  You must setup your samples and groups just as you did with the
default database.

To open an existing database select File, Open and select the database.  Click OK and the
database will be opened.

BOD Analyst software data files can be located anywhere (i.e. the local drive, network drive).  In
a network environment, two workstations CAN have the same data file open.  If two users open
the batch for 8/30/1999 at the same time, the user who leaves the batch last will overwrite
the changes the other user made.

9.4 BACKUP

Printing a Bench sheet every time you finish a run of initials or finals will insure that you will
always have at least the raw data from which you could do the calculations by hand.  However, a
computer failure could also destroy your configuration information (your Samples with their
dilutions etc., and your Sample Groups).  To guard against such a failure you should backup your
BOD Analyst software files at least every week.  The following files should be backed up:

File Description
Data.Mdb Default database
\Reports Subdirectory where all spread report formats exist

Note: If you have created other databases you SHOULD backup those “.mdb” files also.
See the previous section for more information.

9.5 REPAIR

The BOD Analyst software database can become corrupt if the program is closed unexpectedly
because of a power outage or computer hardware problem.   The Repair function rebuilds and
compacts (removes unused space) the database.

Select your datafile and click Repair.



SECTION 10 GRAPHING

10.1 INTRODUCTION

The graphing function provides the ability to produce time series type (Data vs. Time) graphs.
Up to two samples may be displayed at the same time, each on its Y-axis.

To open a sample graph, select Open from the File menu. Open the Data folder, and highlight
the Sample. mdb file and choose OK. In the Trending menu, select Graph. To display the
sample graph, change the Start date to 01/01/99 and the End date to 01/30/99. Choose a topic
from the Sample 1 list (such as Influent), and the Sample 2 list (such as Effluent), and then
choose Graph. A sample graph will appear. The following screen is similar to the sample graph
that you will see.

To generate a new graph, select Graph from the Trending menu.  Edit the Start Date, End Date
and Graph Title fields as desired. Select the names of one or two samples to be displayed and
click the GRAPH button. The following screen is an example of a typical graph.

10.2 GRAPH SETTINGS

The date range of the graph is set or changed by editing the Start Date and the End Date fields.

To change the title displayed at the top of the graph, edit the Graph Title field.
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Sample 1 and Sample 2 are the fields in which the sample names are selected. If one sample
name is selected the left y-axis will be used.  If two samples are selected, both axis will be used,
Sample1 on the left and Sample 2 on the right.  The data line and the axis label are color
coordinated when in color mode.  When black and white printing mode is selected, the second
sample (using the right axis) will use a dashed line and a series of dashes are added to the right
axis title.

Whenever any of the settings change, the GRAPH button text will turn red and a message will
appear in the status bar in the lower left corner saying “Settings have changed, click [GRAPH] to
update”.  These are indications that the currently displayed graph does not accurately depict all of
the settings shown above it.  Simply click the GRAPH button to update the graph.

10.3 PRINTING A GRAPH

Plotting a graph is accomplished by clicking the PLOT button.  Use PLOT SETUP to select a
different printer or to change the orientation of the graph.  A graph will fill an entire page in
landscape orientation and will fill the bottom half of the page in portrait orientation.

If you are plotting the graph on a black and white printer, the Color Toggle button,  , should
be black and white as shown here.  If you have a color printer, click on the Color Toggle button to
change to a more colorful graph.  The bar graph on the Color Toggle button will have color bars
when in color mode. Clicking on the Color Toggle button changes settings on the graph to suit
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differences between printing in color or black and white.

10.4 GETTING STATISTICAL INFORMATION ABOUT SAMPLES

After creating a graph as described above, click on the STATS button to display the Stat Sheet.
This tabbed dialog displays statistical information for each of the variables on the graph.  To
display a statistic, click on the corresponding Plot check box. Statistics can be selected to be
plotted on the graph for Sample 1 only, but statistical information will be displayed on the Stat
Sheet for both samples.

To select statistical lines to be plotted on the graph, click on the Plot checkbox next to the
statistics you want to show then click the OK button.

The default values for the four lines displayed by the Standard Deviation (σσσσ) section are the
Mean ± 2σ and the Mean ± 3σ.  The 2 and 3 can be changed in the two fields above the resulting
values.

The Precision section multiplies the Mean by standard Shewhart factors.  These factors may also
be changed if needed.

The values shown in the Quality Control section are values that have been entered in the QC
fields of the Sample Setup.



SECTION 11 CUSTOMIZING YOUR PROGRAM

The BOD Analyst software is flexible enough to handle the wide variety of ways that people do
their BODs. Some things are very simple and are little more than matters of personal preference.
This section outlines the advanced settings that can be used and specified in the YSI BOD
Analyst for Windows. For others, flexibility is essential because what works well in one
application will give poor results in another. You make your choices on several forms under the
Setup Menu.

11.1 THE BARCODE SCANNER

The barcode scanner can ONLY be used with the YSI 5100 DO instrument. The primary purpose
of the barcode scanner is to eliminate human error.  Depending on exactly how you do your
BODs, it may or may not save you time.  At the YSI Instrument Parameters Form you can set the
barcode scanner to be required, on, or off.   The following table describes each setting.

Setting Description
Required Bottle numbers MUST be scanned in.  No entry from the YSI

5100 Dissolved Oxygen Instrument or the computer keyboard
On Bottle numbers can be scanned in, entered from the YSI 5100

Dissolved Oxygen Instrument or entered from the computer
keyboard

Off Bottle numbers CANNOT be scanned in.  Entry is done from
the YSI 5100 Dissolved Oxygen Instrument or the computer
keyboard.

11.2 AUTO-STABILIZATION

The program can automatically monitor the DO reading for stability.  You set the criteria for
stability based upon your own needs.  You can also tell the program when and how to store the
reading once it is stable.  The biggest advantage is that you no longer have to make a decision
about stability for every single reading.  The program will make the decision for you based upon
your criteria, leaving you free to do other things.  This feature can save you time because readings
are stored as soon as they are stable.  Your BOD results will be more consistent because every
reading is subject to the same criteria.

There are two basic stability criteria, hold time and change.  For example, let's assume that the
hold time is 10 seconds and the change is 0.05 mg/L.  If, in the most recent 10 seconds, the
minimum reading and the maximum reading do not differ by more than 0.05mg/L, the reading is
considered to be stable.  Note that the hold time will be the minimum time that it takes to get a
reading.  The program allows you to define one set of criteria for blanks and another set for all
other samples.

After storing a reading to one bottle, be sure that you move the DO probe to the next bottle
immediately.  The probe can be equilibrating to the solution while you are entering the bottle
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number.

The auto-stable routine starts immediately after the bottle number is entered.  You can choose
exactly how and when a stable reading will be stored; we refer to this as the auto-stabilization
technique.  The fastest way is to store the reading as soon as your stability criteria are met.
Entering the bottle number (by any method) is an implied confirmation that you are ready for the
reading to be stored as soon as it is stable.

You can require that the stability criteria are met and that you have pressed CONFIRM before
storing the reading.  The order does not matter.  If you press CONFIRM before the criteria are
met, the program will wait and then store the reading as soon as it is stable.  If the criteria are met
before you press CONFIRM, then the program will display STBL on the YSI 5000/5100 DO
Instrument and then store the reading when you press CONFIRM.

You can choose to store the reading whenever you press CONFIRM, regardless of the stability
criteria.  The program can display STBL on the YSI 5000/5100 DO Instrument display when the
criteria are met if you choose.

All of the settings for the auto-stable feature are on The YSI Instrument Parameters Form.  See
the section of the same name for detailed instructions.

11.3 THE CRITERIA FORM

BOD testing is complicated due to the number of criteria that tests must meet for acceptance.  The
BOD Analyst software checks tests for compliance with these criteria as they are defined in the
Criteria Setup.  Default values for criteria are based on values recommended in Standard Methods
for the Examination of Water and Wastewater, 20th Edition.  Values may be edited to meet
requirements of state or other regulating agencies.

Maximum Dilution Blank Oxygen Depletion (mg/l)
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Maximum acceptable value for Initial DO minus Final DO in the dilution-blank test.  This
criterion is checked only for Dilution Blank samples.  The default value is 0.2 mg/l.

Maximum Initial Dissolved Oxygen (mg/l)
The maximum acceptable value for the Initial DO. This is checked for all tests.  The default value
is 9.7 mg/l.

Minimum Final Dissolved Oxygen (mg/l)
The minimum acceptable value for the Final DO  This is checked for all tests.  The default value
is 1.0 mg/l.

Minimum (Initial DO - Final DO) (mg/l)
The minimum acceptable value for oxygen depletion.  This is checked for all tests except the
Dilution Blank tests.  The default value is 2.0 mg/l.

Remove Depletion caused by Seed
For the Minimum (Initial DO – Final DO) should the Depletion caused by Seed be removed
before the criteria is applied.  With the field checked, if the depletion is 2.2 mg/l but 0.4 mg/l of
the depletion was caused by seed, the bottle will be marked since the depletion due to the sample
is 1.8 mg/l (2.2 – 0.4).

Minimum Oxygen Depletion % for Seed Tests (%)

The minimum percentage depletion for Seed tests.  Percentage depletion is defined as Final DO /
Initial DO * 100.    Checked for samples that are used as Seed only.  This criterion is not checked
if left blank.  If used, a typical value is 40.

Maximum Oxygen Depletion % for Seed Tests (%)
The maximum percentage depletion for Seed tests. Percentage depletion is defined as Final DO /
Initial DO * 100.    Checked for samples that are used as Seed only.  This criterion is not checked
if left blank.  If used, a typical value is 60.

Use Seed that was closest to 50% depletion
For the entire Seed sample find the bottle (dilution) that is closest to 50% depletion.  Mark all
other bottles in the sample.

Minimum Seed Correction Factor (mg/l)
The minimum acceptable value of the seed correction factor.  The value checked is not the seed
correction per ml.  It is the actual seed correction used in BOD calculations derived by
multiplying the seed correction per milliliter by the amount of seed used in the test.  This is
checked for any test using seed.  The default value is 0.6 mg/l.

Maximum Seed Correction Factor (mg/l)
The maximum value of the seed correction factor.  This is checked for any test using seed.  The
default value is 1.0 mg/l.

Minimum Standard Test BOD (mg/l)
The minimum acceptable value of BOD for tests with the sample name Standard.  The default
value is 163 mg/l (or, 200 minus 37).

Maximum Standard Test BOD
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The maximum acceptable value of BOD for tests with the sample name Standard.  The default
value is 237 mg/l (or, 200 plus 37).

Check Coefficient of Variation
Calculates a Coefficient of Variation (CV) for all dilutions in a sample and checks that value
against the CV limit.  If the CV limit is exceeded, the lowest concentration dilution is removed
from the average and the CV is calculated for the remaining dilutions and the CV is checked
again.  This process is repeated until the calculated CV is within limit or only one bottle remains.

Coefficient of Variation Limit
The maximum acceptable CV for sample BOD data.  This number is typically the CV of GGA
standard tests performed by your laboratory.   Default is 0.35.

Apply Criteria after Final Readings
If checked, each bottle is automatically checked against the criteria when the Final DO readings
are complete.  Alternatively, the CHECK Button on the Bench sheet form can be used to check
all bottles at any time.

11.4 THE GENERAL SETTINGS FORM

You can bring up the General Settings Form by selecting Setup / General from the Main Menu.
The form is used to set the normalization factors and other options.

Normalization Factors - The program will multiply all depletions by the normalization factor for
the day of the final DO. For the typical 5 day BOD, enter the pair (5, 1.00).  If you perform 20
day or 7 day BODs, enter either (20, 1.00) or (7, 1.00).  Up to 20 pairs can be entered, with days
ranging 1 to 99, and factors ranging 0.00 to 2.00.  If you want to estimate a 5 day BOD from
finals done on the 4th or 6th day, enter pairs like (4, 1.13) or (6, 0.91).

Derive initials: You do not need to measure initial DOs for every dilution. The program can
derive the initial DO of a dilution based on the initial DO of another dilution of the same sample,
the initial DO of the blank, and the initial DO of any seed or spike that may be present.  If you
want to use this feature, check the Derive initials option.  Just skip over the dilutions that you
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want the program to derive.  You must measure at least one dilution for each Sample.  It is best to
measure the strongest dilution.  If you measure more than one dilution for a Sample, the program
will use a weighted average of the measured dilutions to derive the others.  The default value is
unchecked (off).

Blank compensation: You may compensate your BODs for the depletion of your blanks by
checking this field.  This is common in the United Kingdom.  The default setting is unchecked
(off). You can change this field at any time

Do you predilute your bottles: Very strong samples sometimes require dilutions that would be
difficult to make in one step.  In these cases, a sizeable quantity of sample is first diluted to a ratio
that will make the final dilutions practical. Sometimes a pre-dilution is called a serial dilution. In
the BOD Analyst software, we call this ratio the pre-dilution.  Some people find it easier to adjust
for the strength of each sample with the pre-dilution while keeping the final dilutions constant for
all samples.  When this box is checked, the Pre Dil column will appear on the bench sheet
allowing for entry of the ratio (ie 2 would be a 2:1 ratio).  If this box is not checked, the Pre-dil
column will be hidden on the bench sheet and no pre-dilution will be allowed.

Volume of bottles (ml): The vast majority of wastewater laboratories in the U.S. use 300 ml
bottles.  Any value is legal.  You can change this field at any time.  The default value is 300.

Dilution unit: Some people like to think of their dilutions as percent (%), others prefer to think
of dilutions as the number of milliliters of sample in a BOD bottle (ml).  Use the pull down list to
make your selection.  You can change this at any time.  Default value is ml.

Seed added to: This field describes the seeding method that you use.  If you do not seed any
samples then you may disregard this field.  If you add seed material directly to each bottle, then
set the field to Bottle.  If you add seed material to the dilution water, then set the field to Blank.
It is important to understand how this field affects the seed Qty: field on the Sample Form.  The
quantity of seed when adding seed material directly to a bottle must be expressed in milliliters.
When adding seed material to the dilution water, the seed quantity must be expressed in milliliters
per liter.  See the section “Seeding Method” for a detailed description.    

Report Font: Sets the font for the Daily Bench Sheet Report and the Everything Report.  The
choices are Arial, MS Sans Serif, Tahoma, and Times New Roman.  If your reports are not
printing correctly it maybe that your printer does not support the selected font.  Therefore, choose
a different font.  The default is Arial.

11.5 THE YSI PARAMETERS FORM

This form is used to describe how the program will work with the YSI 5000/5100 DO Instrument.
To get to the form, select Setup / YSI 5000/5100 Dissolved Oxygen Instrument.  You can
change any of the fields on this form at any time.
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Technique: This field describes exactly how and when a stable reading will be stored.  There are
four legal values, Auto, Dual, Manual, and None.  Auto will start the auto-stable routine
immediately after the bottle number is entered and will store the reading as soon as your stability
criteria are met.  This is the fastest way.  Dual is similar.  It will start the auto-stable routine
immediately after the bottle number is entered but will wait until the stability criteria are met, and
you've pressed CONFIRM before storing the reading.  The order does not matter.  If you press
CONFIRM before the criteria are met, the program will wait and then store the reading as soon as
they are met.  If the criteria are met before you press CONFIRM, then the program will display
STBL on the YSI 5000/5100 DO Instrument and then store the reading when you press
CONFIRM. Manual will store the reading whenever you press CONFIRM, regardless of the
stability criteria.  It will, however, display STBL on the YSI 5000/5100 DO Instrument display
when the criteria are met. None will turn the feature off.  The default value is Manual.

Stabilize timeout: This field is the maximum time in seconds that the program will wait for the
reading to become stable.  If the reading hasn't met your stability criteria by this time, the
program will store the reading anyway.  Legal values are 5 through 500.  The default value is
300.

Sample hold time: This is the hold time in seconds for Samples other than blanks.  For a more
detailed explanation see the “Auto-stabilization” section above.  Legal values are 1 through 300.
The default value is 10.

Sample change: This is the change in mg/L that is allowed during the hold time for a stable
reading.  This field is for all Samples other than blanks.  Legal values are 0.01 through 20.  The
default value is 0.05.

Blank hold time: This is the hold time in seconds for blanks only.  For a more detailed
explanation see the “Auto-stabilization” section above.  Legal values are 1 through 300.  The
default value is 5.

Blank change: This is the change in mg/L that is allowed during the hold time for a stable
reading.  This field is for blanks only.  Legal values are 0.01 through 20.  The default value is
0.02.
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Initial low temp: If the temperature of your initial DO is below this temperature (in °C) the
program will display a warning message at the YSI 5000/5100 DO Instrument before the reading
is stored.  Legal values are 0 through 99.9.  The default value is 16.

Initial high temp: If the temperature of your initial DO is above the temperature (in °C) the
program will display a warning message at the YSI 5000/5100 DO Instrument before the reading
is stored.  Legal values are 0 through 99.9.  The default value is 24.

Final low temp: If the temperature of your final DO is below this temperature (in °C) the
program will display a warning message at the YSI 5000/5100 DO Instrument before the reading
is stored.  Legal values are 0 through 99.9.  The default value is 18.

Final high temp: If the temperature of your final DO is above the temperature (in °C) the
program will display a warning message at the YSI 5000/5100 DO Instrument before the reading
is stored.  Legal values are 0 through 99.9.  The default value is 22.

Supersaturation: If the DO reading is above this value the program will display a warning
message at the YSI 5000/5100 DO Instrument before the reading is stored.  Legal values are 1
through 20 mg/L.  The default value is 9.09.

Bottle numbers: Some people do not use bottle numbers, but use some other way to keep track
of which bottle is which (marked racks, for instance).  If you leave the checkbox unchecked, the
program will not ask for bottle numbers.  The default setting is checked or on.

Barcode reader: Setting this field to on will allow you to use the optional barcode wand to enter
bottle numbers.  When the YSI 5100 Dissolved Oxygen Instrument prompts “Enter Bot# 0”,
simply scan the bottle number. Bottle number entry is only necessary during initials.  During
finals, the user is asked only to confirm bottle numbers entered during the initials.  Setting the
field to Required will force the user to use the barcode reader during both initials and finals.
During initials the YSI prompts “Scan Bottle” and will wait until a barcode is scanned.  During
finals the YSI will prompt for you to scan the bottle.  For example, if the current bottle is 213, the
YSI prompts, “Scan Bot 213” and will wait until 213 is scanned.  This may provide more reliable
results.  Even with this field set to on, you may use the wand during finals.  Required just makes
it mandatory.  If you do not use the barcode reader, set the field to off.  The default setting is on.

11.6 THE COMMUNICATIONS SETUP FORM

This form is used to set the communications settings.  Select Setup / Communications Setup to
display the form.
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Comm port: The program can communicate to the YSI 5000/5100 DO Instrument through either
communications port 1,2,3, or 4.  In this field, indicate the communications port you will use to
connect to the YSI 5000/5100 DO Instrument.  On newer computers, com1: is typically used.  If
the program is unable to initialize communications with the YSI 5000/5100 DO Instrument, then
come back to this form and try a different port.

Baud rate: This is the baud rate for the com port that is hooked to the YSI 5000/5100 DO
Instrument.  The default value for both the YSI 5000/5100 DO Instrument and the BOD Analyst
software is 9600.  9600 is the default and will work for almost all applications, but for long cable
lengths or noisy environments, a slower baud rate may be more reliable, though it will slow the
system response.  We recommend that you use the highest reliable baud rate.  Legal values are
9600, 4800, 2400, 1200, 300, and 110.  See your YSI 5000/5100 Dissolved Oxygen Instrument
manual for more information on how to set it’s baud rate.   The baud rate set here and the YSI
5000/5100 Dissolved Oxygen Instrument’s baud rate MUST be the same.

Note: Data Length, Parity, and Stop Bits are shown for informational purposes only and cannot
be changed.

11.7 SERIAL NUMBERS

Serial Numbers can be used to uniquely define a particular BOD test.   It is important to
understand the difference between Samples and Serial Numbers.   A typical sample may be called
Effluent with dilutions of 100, 150 and 200 ml, and 3 ml of seed added to each bottle.  Suppose a
laboratory is testing the Effluent Sample one day and the program assigns a serial number of 328.
Normally the Serial Numbers increment, therefore the next sample would be number 329.  The
next day, the Effluent sample would be run again but the serial number would be different.
While Sample Names are used over and over, a new serial number is assigned for each new BOD
test.   The Serial Numbers Setup Form is used to specify how the program should implement
serial numbers.  Select Setup / Serial Numbers from the Main Menu.
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Use Serial Number:   Sets whether the program will assign Serial Numbers.  The default is off.

Serialize Each: The program can assign a new serial number to each bottle or each sample.  The
default is Sample.

YSI Displays:  The YSI can display the Sample name or serial number when taking readings.
The default is Sample Name.

Lowest Digits:  Used in conjunction with the Highest Digits field to specify how the software
will increment the serial number.  With these fields you specify the range of each digit.  Each
field is 8 digits long.  Each digit can be an alpha character, a numeric character, or an alpha-
numeric character.  Since each digit is set independently, you can even mix character types.  The
order of characters is:

0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZ

Skip Letters:  Characters listed will not be used in the serial number.

Last Serial Number:  Displays the Last Serial Number that was assigned by the software.  This
field is read only.

The Serial Number will be displayed when reading the initial and final DO on the computer.  On
the bench sheet the current Serial number is displayed on the status bar at the bottom of the bench
sheet.
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Serial Number for
RAW 10 bottle



SECTION 12 CONTACT INFORMATION

For any questions regarding PC6000 software, or any YSI equipment, please contact YSI
Technical Support at (800) 897-4151 or e-mail at support@ysi.com. For ordering YSI equipment
or accessories, please see your YSI dealer, or the contact information below.

1700/1725 Brannum Lane
Yellow Springs, Ohio 45387 USA
(800) 765-4974  (937) 767-7241
FAX: (937) 767-9320
Website: http://www.ysi.com
E-mail: info@ysi.com



SECTION 13 ACCESSORIES

INSTRUMENTS

! 5000-115 Oxygen Instrument, Digital, Lab-115V
! 5100-115 Oxygen Instrument, Digital, Lab with SOUR software – 115V

PROBES

! 5010 BOD Probe, Self-Stirring, 5 ft.
! 5010-J BOD Probe, Self-Stirring, 5 ft.
! 5010-K BOD Probe, Self-Stirring, 5 ft.
! 5010-L BOD Probe, Self-Stirring, 5 ft.
! 5010-W Wine Bottle Probe, Self-Stirring, 5 ft.

INSTRUMENT ACCESSORIES

! 5015 Bar Code Scanner (YSI 5100 DO Instrument ONLY)
! 052021 RS232 Cable, DB9
! 059160, Label set, barcode, waterproof, self-adhesive, 1000 per pack (YSI 5100 DO

Instrument Only)
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